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Chapter 2: The Basics 

Introduction 
This chapter walks you through the basic features and functions of the 
TOPS Pro System.  It's important to understand and master the basics 
first, so we'll work through each of these stages one at a time.  This 
chapter introduces the basic stages in the sequence they are normally 
used in the system, as follows: 

× Control Panel:  Introduces the primary panel in the system, which 
allows you to select the type of analysis you want to perform, the 
stages to be used in the analysis, and the dimensions of each stage. 

× Perform a Simple Analysis:  Walks you through the steps to 
perform a simple shipcase-to-pallet analysis. 

× Analysis View:  Displays the different solutions generated for your 
analysis.  Allows you to select the solution that best meets your 
packing needs. 

× Layer Parameters:  Explains how to apply a number of different 
stages – rotations, pads, trays, slipsheets, caps, secondary patterns – 
to your unitload layers. 

× Print the Analysis:  Explains how to design the layout of the 
printout, including what type of information to include and how to 
present that information (different graphic views, text and numbers, 
etc.). 

× Copy an Image to the Clipboard:  Explains how to select an image 
in TOPS Pro and copy it to the Windows clipboard.  Explains how to 
copy the image into Microsoft Word or Power Point and how to use 
the Paste Special feature. 

× Save the Analysis:  Explains how to save your analysis to the 
database. 

× Direct Email From TOPS Pro:  Allows you to email a standard 
printout directly to another person who may or may not have TOPS 
Pro. 
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Control Panel 
When you login to the system, the Control Panel appears, as pictured 
below.  The Control Panel contains all the primary features of the system:  
Menu Bar, Windows Toolbar, Template Toolbar, Package Design 
Sequence Area, Button-Style Menus and Shortcut Buttons. 

      Menu Bar    Package Design Sequence Area 

 
Windows 
Toolbar 
 
 
 
 

 
 
Template 
Toolbar 
 
 
 
 
 
 
 
 
 
 
 

           
                                 Button-Style Menus                    Shortcut Buttons 
The Control Panel is the primary panel in the system.  It is the working 
area from which you will select the type of analysis you want to perform, 
select the stages to be used in the analysis and define the dimensions of 
each stage. 
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Menu Bar 
The Menu Bar, pictured below, provides a number of drop-down menus.  
These menus provide options that allow you to perform common tasks, 
many of which are duplicated on the Button Bar and Shortcut Buttons. 

 

The list below gives a brief description of the eight menus on the Menu 
Bar: 

× File Menu:  Allows you to create new records, open existing records, 
save records and set up print parameters. 

× Edit Menu:  Allows you to copy text and images to the Windows 
clipboard, as well as work with secondary pallet patterns. 

× View Menu:  Allows you to view graphic images in a number of 
formats:  3-D, front, side, split screen, quad screen and others. 

× Define Menu:  Allows you to define parameters for new products, 
cartons, shipcases, pallets, vehicles, etc. 

× Tools Menu:  Allows you to revise your TOPS Pro configuration, the 
language used in TOPS Pro (TOPS Pro is used worldwide), stacking 
strength parameters, color selections, etc. 

× Export Menu:  Allows you to export different types of graphic files 
(.bmp, .tiff, .jpeg), analyses, product reports, etc. 

× Supervisor Menu:  Allows you to perform supervisor functions such 
as login/logout tasks, access approval and denial, template setup, etc. 

× Help Menu:  Allows you to display Help information for all features 
and functions in the system. 

Note:  For detailed information about all the menus and menu options 
included on the Menu Bar, please refer to Appendix C, Menu Options. 
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Windows Toolbar 
The Windows Toolbar, as pictured below, contains a number of icons 
that allow you to perform standard, routine functions.  It also provides 
direct links to parameter dialog boxes for primary packages, intermediate 
packers, shipcase, unitloads and vehicles so you can modify those 
parameters without losing your place in the analysis. 

 

The following table outlines the icons found in the Toolbar and its 
corresponding purpose. 

Icon Function 

 New Analysis:  Clears the Package Design Sequence area and 
allows you to start a new analysis. 

 
New Based on Predefined Template:  Opens the Open 
Analysis dialog box and allows you to select a predefined 
analysis template. 

 
Open:  Opens the Open Analysis dialog box and allows you to 
select an analysis. 

 
Save:  Saves the analysis. 

 
Print:  Prints the analysis. 

 
Previous:  Takes you to the previous step in the Package 
Design Sequence for an analysis. 

 
Next:  Takes you to the next step in the Package Design 
Sequence for an analysis.  If there is no next step, this icon 
takes you back to the Package Design Sequence. 

 
Cancel to Package Design Sequence:  Cancels out of the 
active analysis and takes you back to the Package Design 
Sequence area, where you can start over. 

 
Design CASY Primary Package:  Opens the CASY Primary 
Package Screen. 

 
Design CASY Shipping Case/Tray:  Opens the CASY 
Shipping Case/Tray Screen. 
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Icon Function 

 
MixPro Mixed Pallet Editor:  Opens the MixPro Pallet for 
Display Editor, used to create mixed pallets. 

 MixPro Mixed Tray Editor:  Opens the MixPro Tray for 
Display Editor, used to create mixed trays. 

 
Modify Primary Pack Parameters:  Opens the parameters 
dialog box for the appropriate primary package (bottle, can, 
etc.) in the Analysis View. 

 
Modify Intermediate Pack Parameters:  Opens the 
parameters dialog box for the appropriate intermediate packer 
(etc.) in the Analysis View. 

 
Modify Shipcase Parameters:  Opens the Shipcase 
Parameters dialog box in the Analysis View. 

 
Modify Unitload Parameters:  Opens the Unitload 
Parameters dialog box in the Analysis View. 

 
Modify Vehicle Parameters:  Opens the Vehicle Parameters 
dialog box in the Analysis View. 

 
Switch to Related KD Analysis:  Not currently active. 

 
Switch to Related Box Analysis:  Not currently active. 

 
Show CASY:  Serves as a toggle switch to turn on or off the 
CASY graphics display. 

 
Stacking Strength:  Opens the Stacking Strength dialog box. 

 
All Stages Enhanced View:  Opens an All View pane with 
all stages of an analysis in the Analysis View. 

 
Flying Toolbar:  Serves as a toggle switch to turn on or off 
the Flying Toolbar. 

 Combined Report: Allows you to compare two solutions at 
the same time. 
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Template Toolbar 
The Template Toolbar, pictured below, gives you easy access to analysis 
templates set up in the system.   

Notice the first button in the 
toolbar to the left.  This 
template button shows four 
stages of an analysis:  
Can/Cylinder-Shipcase-Pallet-
Vehicle. 

If you click on this button, 
TOPS Pro automatically inserts 
the corresponding icons in the 
Package Design Sequence Area. 

As you set up the stages that 
make up an analysis, TOPS Pro 
allows you to save the analysis 
as a template and add it to the 
Template Toolbar.  For more 
information, please refer to the 
section “Perform a Simple 
Analysis.” 
 

 

Button-Style Menus 
The Button-Style Menus, pictured below, allow you to set up a Package 
Design Sequence, in which you select the various stages to be used in an 
analysis.

 

There are six Button-Style Menus, each represents a stage of an analysis. 

Each button-style menu contains a list of items that allows you to define 
the stages of an analysis with any combination of items you need.  To 
select an item, click on the graphic representation of the item in the list, 



Chapter 2:  The Basics 2-7 

then click on the text button at the top of the list.  As you select each 
stage, the corresponding icon will appear in the Package Design 
Sequence Area of the Control Panel.  To remove an icon from that area, 
simply click on the text button again. 

Note:  Be aware that there are a few duplications in the button-style 
menus that should be clarified. 

× Carton Icons:  There are two Carton icons.  The Box Carton icon 
(green) displays the Carton Parameters dialog box.  The Intermediate 
Pack Carton icon (blue) displays the Intermediate Pack Parameters 
dialog box. 

× Tray Icons:  There are two Tray icons.  The Intermediate Pack Tray 
icon (blue) displays the Intermediate Pack Parameters dialog box.  
The Shipper Tray icon (yellow) displays the Shipcase Parameters 
dialog box. 

× Bag Icons:  There are two Bag icons.  The Film Bag icon (green) and 
the Shipper Bag icon (yellow) both display the Bag Parameters dialog 
box.  However, you'll use the first Film Bag icon to design a bag that 
contains a product.  You'll use the Shipper Bag icon to put a bag onto 
a pallet. 

× Bottle Icons:  There are two Bottle icons.  The Bottle icon (green) 
and the Shipper Bottle icon (yellow) both display the Bottle 
Parameters dialog box.  However, you'll use the first Bottle icon to 
design a bottle that goes into a shipcase.  You'll use the Shipper 
Bottle icon to design a bottle that goes onto a pallet. 
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Package Design Sequence 
The Package Design Sequence Area is the area on your screen in which 
you define a series of stages for an analysis.  For example, let's say you 
selected six stages from the Button-Style Menus:  bulk, bag, carton, 
shipper, pallet and truck.  The corresponding icons will appear in the 
Package Design Sequence Area, as pictured below. 

 

The icons you see in this figure are often referred to, respectively, as the 
Bulk Parameters icon, the Bag Parameters icon, the Carton Parameters 
icon, the Shipper Parameters icon, the Unitload Parameters icon and the 
Transit Vehicle Parameters icon. 

This represents a Package Design Sequence in which you'll find the best 
solution for this analysis:  bulk product into a bag, into a carton, into a 
shipcase, onto a pallet and into a truck. 

Next, when you click on any of these icons, a dialog box will appear and 
allow you to define the parameters of that particular stage in the 
sequence.  For example, when you click on the Bottle icon, the Bottle 
Parameters dialog box appears, and you'll tell the system precisely how 
your bottles are designed in terms of dimensions, weight, shape, etc. 

You can also click the Calc button on the lower right hand corner to start 
defining parameters for each stage. 
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Shortcut Buttons 
The Shortcut Buttons, pictured below, allow you to view and calculate 
solutions for an analysis. 

 

× View Button:  Allows you to display and view the solution panels 
(Analysis View) for a selected analysis.  This function becomes 
active only after an analysis has been completed. 

× Calc Button:  Allows you to calculate solutions for an analysis.  
After you've selected all the stages for the analysis and defined 
parameters for each stage, the Calc button tells the system to generate 
all possible solutions for the analysis, given the data you entered. 

If you click on the Calc button and your analysis is incomplete – you 
forgot to enter a necessary detail – TOPS Pro automatically displays the 
appropriate dialog box and prompts you to enter the missing data.  If 
you've simply made changes to the analysis, the system allows you to 
look over the changes you made before you continue. 
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Perform a Simple Analysis 
To follow through with the basics of the TOPS Pro software, this section 
walks you through a simple analysis and leads to the Analysis View, 
which is presented in the next section.  This analysis – shipcase onto a 
pallet – is very common and considered simple because it involves only 
two stages. 

In this analysis, we'll set up a shipcase and a pallet, as follows: 

× The shipcase is 17 inches long, 13 inches wide, 11 inches high and 
weighs 10 pounds. 

× The pallet that has no overhang. 

Define the Package Design Sequence 
To perform this analysis, start from the Control Panel and click on the 
Shipper and Pallet icons. 

 

Save the Package Design Sequence as a Template 
The shipcase-to-pallet sequence is a routine analysis that you’ll perform 
frequently.  TOPS Pro allows you to save this analysis as a template and 
add it to the Template Toolbar. 

To save the Package Design Sequence as a template, follow these 
instructions: 

1. Go to the Menu Bar and open the File Menu. 

2. From the File Menu, click on the Save As Template option.  The 
Analysis Save As dialog box, as pictured on the next page, appears. 
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3. In the Description field, enter the name of the new template (e.g., 
Shipcase -> Pallet) and click on OK. 

TOPS Pro saves the new template to the database and adds it to the 
Template Toolbar.  The next time you want to perform this analysis, 
simply go to the Template Toolbar and click on the “Shipcase -> Pallet” 
template button to start the analysis. 

Note:  To display the Template Toolbar on the Control Panel, go to the 
Configuration dialog box and select the Display Template Buttons option. 
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Define Shipcase and Pallet Parameters 
To define parameters for the shipcase and pallet, follow these steps: 

1. Click on the Shipper icon in the Package Design Sequence area. 

 

2. Enter data to define your shipcase parameters, as follows: 

× Length (in):  Enter 17. 
× Width (in):  Enter 13. 
× Height (in):  Enter 11. 
× Case (lbs):  Enter 10. 

3. After completing the shipcase parameters, click on OK.   
 
TOPS stores your parameters to memory and closes the Shipcase 
Parameters dialog box. 



Chapter 2:  The Basics 2-13 

4. Click on the Pallet icon in the Package Design Sequence area and the 
UnitLoad Parameters dialog box, as shown below, appears. 

 

5. Enter data to define your unitload parameters, as follows: 

× Maximum Overhang Length (in):  Enter 0. 
× Maximum Overhang Width (in):  Enter 0. 

 
6. After completing the unitload parameters, click on OK. 

 
TOPS stores your parameters to memory and closes the UnitLoad 
Parameters dialog box. 

7. Click on the Calc button to generate solutions for the analysis. 

TOPS Pro uses the defined parameters – shipcase and unitload – and 
generates all possible solutions for the analysis.  When the calculation is 
complete, the Analysis View appears.  The next section discusses the 
Analysis View in detail. 
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Revise Parameters for an Analysis (if necessary) 
To revise any parameters for an analysis that has not yet been generated 
(you've not yet clicked on the Calc button), follow these instructions: 

1. Click on the appropriate icon. 

2. Use the dialog box to make the necessary changes. 

To revise any parameters for an analysis that has already been generated, 
follow these instructions: 

1. Click on the appropriate Modify icon in the Windows Toolbar.  For 
example, to revise shipcase parameters, click on the Modify Shipcase 
Parameters icon. 

 

2. Enter the necessary changes in the Shipcase Parameters dialog box. 

3. Click on the OK button. 

TOPS Pro uses your changes to generate a new set of solutions. 
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Analysis View 
When TOPS Pro generates solutions for an analysis, it displays the 
Analysis View, as pictured below.  You'll use the Analysis View to study 
the different solutions and select the one that best meets your packing 
needs. 

 

The Analysis View is normally divided into three panes, which work in 
conjunction with one another.  Let's talk about these three panes one at a 
time. 

× Solution View Pane:  This pane, in the top left portion of the screen, 
displays a graphic of what the selected unitload solution looks like – 
i.e., how the shipcases have been loaded onto the pallet. 

× Statistics View Pane:  This pane, in the top, right portion of the 
screen, displays detailed statistics for the selected solution. 

× Solution List Pane:  This pane, at the bottom of the screen, displays 
a list of the best 50 (if there are 50) solutions generated for the 
analysis, along with a variety of basic information for each solution. 
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Solution View Pane 
The Solution View pane displays a 3-D graphic of what the selected 
solution looks like; this pane is linked to the Solution List pane at the 
bottom.  For example, if you select Solution 1 in the Solution List, the 
Solution View displays a graphic that corresponds to Solution 1.  If you 
select Solution 5 in the Solution List, the Solution View displays a 
graphic for Solution 5, and so on. 

In this analysis, the UnitLoad Solution View pane, pictured below, shows 
a graphic view for Solution 1. 

 

Notice the following features on this pane: 

× Type of Solution:  The title bar of the pane reads "UnitLoad View 1 
of 19."  If this were a Carton solution, the title bar would read "Carton 
View ..." 

× Solutions Counter:  The title bar of the pane shows a counter (for 
example, 1 of 19).  This tells you that this is the first of 19 solutions 
generated by the system. 

×   Alternate Pallet Patterns:  For a given solution, there might be 
a number of alternate ways you can configure the unitload on the 
pallet.  For each possible configuration, TOPS Pro displays a button 
on the left side of the pallet.  In the figure on the previous page, two 
buttons correspond to two possible configurations for Solution 1.  If 
there were six possible configurations, the pane would display six 
different buttons. 
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If you click on a button, the pane redraws to show the selected 
configuration.  If there were a large number of buttons, the scroll bar 
would allow you to access all the available buttons. 

Note:  Keep in mind that these buttons do not represent different 
solutions, but different configurations for a single solution. 

× Dimensions:  The graphic shows dimensions – length, width and 
height – for the solution. 

Note:  Be aware that the dimensions display depends on whether 
you've turned on that feature in the Configuration settings. 

Also, if the dimensions shown here are not the dimensions you'd like 
to see, try turning on or off the UL Size as Pallet Size switch on the 
Configuration dialog box.  For more information on the Configuration 
dialog box, please refer to Appendix B, Dialog Boxes. 

× Scroll Bar:  The scroll bar on the right side of the pane allows you to 
display each successive solution in the list.   

For example, if you click on the down button on the scroll bar, the 
pane displays the next solution in the list.  If you click on the up 
button, the pane displays the previous solution in the list.  If you 
scroll all the way down, the pane displays the final solution in the list; 
all the way up displays the first solution. 

× QPrint Button:  Displays the Quick Print dialog box, which allows 
you to define print parameters and print the graphic in the pane. 

Note:  For more information on the Quick Print dialog box, please 
refer to Chapter 11, Printing, or Appendix B, Dialog Boxes. 

× Modify Button:  Displays the Pallet Pattern Editor, which allows you 
to add, remove and reposition shipcases on a pallet. 

× Strength Button:  Opens the Stacking Strength dialog box, which 
allows you to calculate compression strength on the shipcase. 

Note:  For more information on stacking strength, please refer to 
Chapter 9, Stacking Strength. 
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Solution View Menu 
As you’re working with an analysis, the Solution View features a menu 
with a number of useful functions.  With the Solution View active, right-
click inside the Solution View pane and a small menu appears, as 
pictured below on the right 

The Solution View Menu provides the following options: 

× Next:  Displays the next stage of the analysis in 
Solution View. 

× Previous:  Displays the previous stage of the analysis 
in Solution View. 

× Cancel:  Closes the Analysis View and returns you to 
the Control Panel. 

× Show:  Leads to a submenu to select items to be 
displayed in the solutions: dimensions, contents, 
bitmaps, CASY style, shrinkwrapped, strapped and markers. 

× View:  Allows you to view the image in a variety of formats:  3-
dimensional, plan, front, side, as text (statistics), single stack, pop top, 
double stack, assembly and exploded. 

× Divider 3D:  If the shipcase includes dividers, this option displays 
the image in 3-dimensional format, including the dividers. 

× Divider Plan:  If the shipcase includes dividers, this option displays 
the image in plan format, including the dividers. 

× Save Image:  Provides a number of options for saving the Solution 
view image – as a bitmap file, JPEG file, PDF file, etc. 

× Print:  Allows you to print the Solution View image. 
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× Pop Corner:  For a unitload image, this option displays one corner of 
the load exposed so you can see the contents.  A pop corner view of a 
unitload is pictured below. 

 
Solution View with Pop Corner option enabled 

× Clear Case:  For a unitload image, this option displays the shipcases 
as clear cases so you can see the contents.  A clear case view of a 
unitload is pictured below. 

 
Solution View with Clear Case option enabled 



2-20 TOPS Pro (Version 5.6X) User Guide  

Statistics View Pane 
The Statistics View pane displays detailed statistics for a selected 
solution; this pane is linked to the Solution List pane.  For example, if 
you select Solution 1 in the Solution List, the Statistics View displays 
data for Solution 1.  If you select Solution 5 in the Solution List, the 
Statistics View displays data for Solution 5, and so on. 

In this analysis the UnitLoad View pane, pictured below, shows statistics 
for Solution 1.  The Text View pane automatically sizes the information 
displayed to the window size.  You can add and remove rows and 
columns of statistics by using the Statistics dialog box.  For more 
information about the Statistics dialog box, please refer to Appendix B, 
Dialog Boxes. 

 

Notice the following features on this pane: 

× Type of Solution:  The title bar of the pane reads "UnitLoad View 1 
of 10."   

× Solutions Counter:  The title bar of the pane shows a counter (for 
example, 1 of 10).  This tells you that this is the first of 10 solutions 
generated by the system. 

× Detailed Statistics:  The pane presents detailed statistics for the 
selected solution – most of the same information you see in the List 
pane. 
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× Scroll Bar:  The scroll bar on the right side of the pane allows you to 
move up and down the display area of the pane. 

× QPrint Button:  Displays the Quick Print dialog box, which allows 
you to define print parameters and print the statistics in the pane. 

× Modify Button:  Displays the Pallet Pattern Editor screen, which 
allows you to add, remove and reposition shipcases on a pallet. 

× Strength Button:  Displays the Stacking Strength dialog box, which 
allows you to define stacking strength parameters for the unitload. 

Solution List Pane 
The Solution List pane displays a list of all solutions generated for the 
analysis.  In the figure below, the Solution List pane includes 19 
solutions for the analysis (only seven are visible).  A scroll bar allows 
you to move up and down the list.  For each solution, this pane displays 
different items of basic information, which appears in columns across the 
pane, depending on the type of analysis performed. 

Important Note:  In order to see all displayed columns of information in 
the Solution List pane, be sure to maximize the Analysis View.  If you 
still can't see all columns, try increasing your video resolution. 

Also, units of measurement (English or Metric) used in the Solution List 
pane are set up in Configuration. 

 

Depending on the analysis performed, the Solution List pane displays 
some/all of the following items of information: 

× Sol: Identifies the solution (Solution 1, 2, 3, etc.). 

× Case Wgt:  The gross weight of the shipcase. 

× Vol (ID):  The volume of the shipcase, based on inside dimensions. 

× Slack (Len, Wid & Hgt): The amount of unused space along the 
Length, Width and Height of the shipcase. 
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× Ptrn Type: The stacking pattern used to configure the shipcase. 

× Note:  For detailed information about pallet patterns, please refer to 
Appendix D, Pallet Patterns. 

× Cubic Eff (Shipcase):  The percentage of cubic area that is used. 
TOPS Pro calculates this value based on how much space is being 
used versus the space you're trying to fill in the shipcase.. 

× Dim Vert: The dimension – length, width or height – specified as the 
vertical dimension of the shipcase relative to the ground. 

× Unitload Width:  The width of the unitload. 

× Height:  The height of the unitload, including the pallet. 

× Unitload Weight:  The weight of the unitload, including the pallet. 

× Cases/Layer:  The number of shipcases configured in each layer of 
the unitload. 

× Layers/Unitload:  The number of layers of shipcases configured in 
the unitload. 

× Cases/Unitload:  The number of shipcases configured in the unitload. 

× Area Efficiency:  The percentage of the pallet area that is used in the 
configuration.  TOPS Pro calculates this value based on how much 
pallet area is covered by shipcases. 

× Cubic Efficiency:  The percentage of cubic area that is used in the 
configuration.  TOPS Pro calculates this value based on how much 
space is being used versus the space you are trying to fill. 
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Display Thumbnail View of Pallet Patterns 
TOPS Pro includes a feature that displays a thumbnail image of each 
unitload solution generated for an analysis.  This allows you to see all 
available pallet patterns at a glance.  Follow these instructions: 

1. Open the Tools menu. 

2. Click on Configuration to open the Configuration dialog box displays, 
as pictured below. 
 

 

3. Select the Thumbnails for Unitload List option and click on OK. 

 
The next time you generate a solution and the Unitload List displays, 
each unitload solution will be represented by a thumbnail image of the 
pallet pattern, as pictured below. 
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Layer Parameters 
Once you've decided on a solution, you can work with the individual 
layers in the unitload.  The Layer Parameters feature allows you to apply 
a number of different stages to your unitload layers, including the 
following: 

× Rotate selected layers. 
× Use the secondary pattern set up for selected layers. 
× Add caps, pads, slipsheets and trays to selected layers. 

 
This feature allows you to select whichever layers you want – one, 
multiple, all or none – then apply a function to those selected layers.  You 
have the flexibility to define layer parameters any way you want. 

To define layer parameters, you'll use the Layer Parameters dialog box.  
To access this dialog box, follow these instructions: 

1. On the Analysis View, make sure one of the UnitLoad View panes is 
active.  (You can't access Layer Parameters if the List pane is active.)  
For example, click on the 3-D drawing of the pallet in the Graphic 
View pane. 

2. From the menu bar, open the Edit menu and select Layer Parameters. 
The Layer Parameters dialog box appears, as pictured below: 
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× Cap:  Check the box to insert a cap over a specific layer in the 
unitload. 

× 2nd Pat:  Check the box to use a secondary pattern for a specific 
layer in the unitload. 

Function Buttons 
The Layer Parameters dialog box includes 14 function buttons, as 
follows: 

× Rotate All Button:  Rotates all layers in the unitload.  When you 
click on this button, TOPS Pro automatically checks all the active 
boxes in the Rotate column. 

× Rotate Top 2 Button:  Rotates the top two layers in the unitload. 

× Clear Rotate Button:  Clears all the Rotate commands already set up 
for the unitload.  When you click on this button, TOPS Pro 
automatically un-checks all the active boxes in the Rotate column. 

× Pad All Button:  Inserts pads between each layer in the unitload.  
When you click on this button, TOPS Pro automatically checks all the 
active boxes in the Pad Under column. 

× Pad Even Button:  Inserts pads under only the even-numbered layers 
in the unitload.  When you click on this button, TOPS Pro 
automatically checks all the active boxes in the Pad Under column for 
even-numbered layers. 

× Clear Pads Button:  Clears all the Pad commands already set up for 
the unitload.  When you click on this button, TOPS Pro automatically 
un-checks all the active boxes in the Pad Under column. 

× Slips for All Button:  Inserts slipsheets between each layer in the 
unitload.  When you click on this button, TOPS Pro automatically 
checks all the active boxes in the Slipsheet column. 

× Clear Slips Button:  Clears all the Slipsheet commands already set 
up for the unitload.  When you click on this button, TOPS Pro 
automatically un-checks all the active boxes in the Slipsheet column. 

× Trays for All Button:  Places every layer in the unitload on a tray.  
When you click on this button, TOPS Pro automatically checks all the 
active boxes in the Tray column. 
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× Clear Trays Button:  Clears all the Tray commands already set up 
for the unitload.  When you click on this button, TOPS Pro 
automatically un-checks all the active boxes in the Tray column. 

× Caps for All Button:  Places a cap on every layer in the unitload.  
When you click on this button, TOPS Pro automatically checks all the 
active boxes in the Cap column. 

× Clear Caps Button:  Clears all the Cap commands already set up for 
the unitload.  When you click on this button, TOPS Pro automatically 
un-checks all the active boxes in the Cap column. 

× 2nd Pat for All Button:  Replaces all the current layers in the 
unitload with the selected secondary pattern.  When you click on this 
button, TOPS Pro automatically checks all the active boxes in the 2nd 
Pat column. 

× Clear 2nd Pat Button:  Clears all the Tray commands already set up 
for the unitload.  When you click on this button, TOPS Pro 
automatically un-checks all the active boxes in the Tray column. 

× Next Page Button:  If the solution has more than 16 layers, the Next 
Page button will appear below the Help button.  This allows you to 
select parameters for the next 16 layers. 

Filler 
Filler serves primarily to fill empty space between layers, which prevents 
load shifting.  The Filler function allows you to specify how filler will be 
used, as follows: 

× None:  No filler is inserted between layers. 

× Middle Filler:  Inserts filler in the middle of the layers. 

× End Filler:  Inserts filler at the ends of the layers. 

Spread 
The Spread function allows you to specify how the layers will be spread 
on the pallet, as follows. 

× Pack Tightly:  Shipcases in each layer are packed tightly toward the 
center, with minimum spread in between. 

× Spread to Layer Edge:  Shipcases in each layer are spread to the 
edge of the unitload.  This option "squares up" the unitload. 
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× Spread to Pallet Edge:  Shipcases in each layer are spread to the 
edge of the pallet. 

Rotate 
The Rotate function allows you to specify how the layers will be rotated, 
as follows: 

× Length Flip:  Flips the layer pattern along its length. 

× Width Flip:  Flips the layer pattern along its width. 

× Length and Width Flip:  Rotates the layer along both its length and 
width. 

× Rotate 90 Degrees:  Rotates the layer 90 degrees. 
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Print the Analysis 
TOPS Pro provides a lot of flexibility in the way you design and print 
analysis output.  After you've decided on a solution, you're ready to print 
a hard copy that shows the information that went into the analysis. 

You'll design the layout of the printout, then decide what type of 
information will be included and how that information will be presented 
(different graphical views, text and numbers, etc.). 

In this example, we'll design the output to have the following 
characteristics: 

× The output will have a 3-Way Bottom page layout. 

× The heading will read "Shipcase-to-Pallet Analysis." 

× The three areas of the printout will show the UnitLoad 3D View, the 
UnitLoad Plan View and the UnitLoad Statistics. 

× The bottom of the printout will show sample text. 

Define Print Parameters 
To print the output from an analysis, start from the Control Panel and 
follow these instructions: 

1. Go to the Menu Bar and open the File menu. 

2. Select Print Preview, then select Analysis. The Print Parameters 
dialog box appears, as pictured on the next page. 
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Notice that the Print Parameters dialog box is organized into the 
following sections: 

× Page Layout:  Allows you to select one of eleven possible page 
layouts: 

Á The Full Page layout allows you to select only one area of the 
analysis to print. 

Á The Horizontal Split and Vertical Split layouts allow you to 
select two areas of the analysis to print. 

Á The 3 Way Bottom, 3 Way Top, 3 Way Left and 3 Way Right 
layouts allow you to select three areas of the analysis to print. 

Á The Quad Split layout allows you to select four areas of the 
analysis to print. 
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Á The 5 Way and 5 Way Down layout allows you to select five 
areas of the analysis to print. 

Á The 6 Way Fixed, 6 Way Scaled and 6 Way Down layouts has 
all six areas of the analysis to print. 

× Heading:  Allows you to enter the text of the heading that will appear 
at the top of the printout. 

× Areas 1 through 6:  Allow you to select the area(s) of the analysis 
from which you want to print information. 

Note:  Be aware that the number of areas available to select from 
depends on the page layout you selected.  For example, if you 
selected the Horizontal Split layout, which contains two sections, 
you'll be able to select from only two areas. 

× Notes:  Allows you to enter the text of any notes that will appear at 
the bottom of the printout. 

Tip:  To force the text to wrap to the next line, type a left apostrophe 
(`) at the end of the line of text.  In a normal word processor 
application, you'd use the Enter or Return key to do this. 

× Show Additional Notes:   Allows you to enter information about 
such as Label Format, Test Weight and Package Quantity. 

× Printer:  Allows you to select either Black and White (B+W) or 
Color printing. 

Note:  Black-and-white printing is basically a line drawing, while 
color printing is a 3-D shaded halftone. 

× Double Stack Unitload:  Allows you to print output as a double-
stacked unitload. 

× Print Analysis Name:  Allows you to print the analysis name on the 
printout. 

× Show Graphics/C.A.S.Y.:  Allows you to show graphics or CASY 
design in the printout. 

Note:  If the analysis includes both graphics and a CASY design, the 
system will display the CASY design, not both. 
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× Font: Here you can select the font on the preview screen. The text 
can be displayed in the following 3 sizes. 

Á Regular:   Helvetica  10 pt 
Á Small:   Helvetica    8 pt  
Á Very Small:  Helvetica    6 pt 

 
3. Enter print parameters for the analysis.  Use the Tab key to move 

from field to field.  For the purpose of this example, we'll enter the 
following parameters 

× Page Layout:  Select 3 Way Bottom. 
× Heading:  Enter "Shipcase-to-Pallet Analysis." 
× Area 1:  Select UnitLoad 3D View. 
× Area 2:  Select UnitLoad Plan View. 
× Area 3:  Select UnitLoad Statistics. 

 
Notes:  For exercise purposes, enter the following text:  "This is 
where you'll enter any text that you want to appear at the bottom of 
your printout." 

 
4. After completing the print parameters, click on OK.  The Print 

Preview panel appears, as pictured below. 

 

Notice the following things about the Print Preview panel: 
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× The heading reads "Shipcase-to-Pallet Analysis" and includes 
today's date.  The heading also includes a title, if you specified a 
title. 

× Area 1 displays a graphic of the UnitLoad 3D View. 

× Area 2 displays a graphic of the UnitLoad Plan View. 

× Area 3 displays the UnitLoad Statistics. 

× At the bottom of the printout, the Notes section displays the 
sample text you entered. 

× The Zoom button allows you to magnify the panel and get a 
closer, more detailed look at the output. 

× The Print button sends the output to the printer. 

× The Email button allows you to email this report to another user. 

5. To print the output, click on the Print button. 

Add Text or Images to Printed Output 
After you've designed and generated your analysis output, the system 
allows you to add text or graphic images to the output before you print it.  
This is a very easy process that allows you to customize and enhance the 
output's presentation. 

To add text and images to the output, start from the Print Preview panel 
and follow these instructions: 

1. Click on the Zoom button.  TOPS Pro magnifies the Print Preview 
panel. 

2. Click on the area of the output where you want to enter text.  TOPS 
Pro displays a four-cornered entry field with the cursor positioned 
inside the field.  Notice that you can "drag" the entry field to any 
position on the screen. 

3. Enter the text that you want to appear in the selected area. 

In this exercise, enter text as follows: 

× In Area 1 (top left), click above the graphic and enter this text:  
"UnitLoad 3D View." 

× In Area 2 (bottom left), click above the graphic and enter this text:  
"UnitLoad Plan View." 
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× In Area 3 (bottom right), click above the graphic and enter this 
text:  "UnitLoad Statistics." 

4. Drag the text fields so they're positioned where you want them.   

In this example, we'll drag the text fields so that they're centered at 
the top of each area, above the graphics or statistics.  Now that you've 
entered your text, suppose you want to add a graphic image to an 
area. 

5. Go to the Menu Bar and open the Edit Menu. 
 
Select Paste Pict From File.  The Select File dialog box appears, as 
pictured below. 
 

 
 
Notice that this dialog box displays a list of bitmap files. 

6. Select the tops.bmp file and click on OK.  The Print Preview panel 
redisplays with the selected TOPS Pro bitmap file inserted into the 
output. 

7. Drag the image to the area where you want it to appear. 

8. After completing the text and graphics, click on the Print button.   
TOPS Pro sends the analysis output to the printer. 

9. Click on the Close button.  TOPS Pro asks if you want to save your 
changes. 
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10. Click on Yes.  TOPS Pro prompts you to enter a filename to be saved. 

11. Enter the name of this file and click on OK. 

12. TOPS Pro returns you to the Control Panel. 

Change the Printer Pen Width 
The printer pen width refers to the thickness of the lines in a graphic or 
text when you print an analysis.  The default for printer pen width is zero, 
which is a hairline width. 

To change the printer pen width, follow these instructions: 

1. From the menu bar, open the Tools menu. 

2. Select Configuration and the Configuration dialog box appears. 

3. In the Printer field, enter a value to specify the line thickness with 
which you want to print. If you're satisfied with the printer, click on 
OK. 

TOPS Pro saves the updated configuration to the database and returns 
you to the previous screen. 

Note:  Printer pen width has no effect when CASY graphics are turned 
on. 
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Copy TOPS Graphics to Other 
Programs 
For TOPS Pro users, it is common practice to copy graphic images from 
the system into other applications.  This section addresses the following 
routines and features: 

× Copy a single graphic 
× Copy the entire Print Preview 
× Copy a graphic to Microsoft Word 
× Copy a graphic to Microsoft Power Point 
× Paste Special 

 
When you copy an image to the clipboard, a second representation of the 
image is put into the clipboard.  If the Show Graphics feature is turned 
on, then only a raster (also known as a bitmap) will be available for 
pasting.  If the Show Graphics feature is turned off, then both a raster and 
vector image (also known as WMF) will be placed in the clipboard. 

Copy a Single Graphic 
To copy a single graphic to the clipboard, follow these instructions: 

1. Click on a graphic to select it. 

Note:  You may want to resize the window to the size of the desired 
image before copying.  For better printing, make the image twice as 
large. 

2. Go to the menu bar and open the Edit menu. 
To copy the graphic in color, select Copy to Clipboard Color. 
To copy the graphic in black and white, select Copy to Clipboard 
B+W. 

TOPS Pro copies the selected graphic to the clipboard, from which it can 
be pasted into any other Windows program. 

Copy the Entire Print Preview 
To copy the Print Preview to the clipboard, start from Print Preview 
mode and follow these instructions: 
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1. Click on the Zoom button and TOPS Pro redisplays the Print Preview 
in zoom mode. 

Note:  If you don't zoom in, you'll capture an exact image of the 
zoom-out state, including the wide margins. 

2. Go to the menu bar and open the Edit menu. 

3. To copy the Print Preview in color, select Copy to Clipboard Color. 
To copy the Print Preview in black and white, select Copy to 
Clipboard B+W. 

TOPS Pro copies the Print Preview to the clipboard. 

Copy a Graphic to Microsoft Word 
To copy a graphic to Microsoft Word, follow these instructions: 

1. Copy a graphic to the clipboard. 

2. Open the Microsoft Word application. 

3. Paste the graphic in the Word document. 

4. Go to the Word menu bar and open the Format menu. 

5. Select Picture and the Format Picture dialog box appears, as pictured 
below. 
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6. Use the Picture dialog box to size the graphic in the Word document. 

Note:  For detailed information about defining Picture parameters, 
please refer to your Microsoft Word documentation. 

Copy a Graphic to Microsoft Power Point 
To copy a graphic to Microsoft Power Point, follow these instructions: 

1. Copy a graphic to the clipboard. 

2. Open the Microsoft Power Point application. 

3. Paste the graphic in the Power Point presentation. 

4. Use the Power Point edit function to edit the graphic in the Power 
Point presentation. 

Note:  For detailed information about the Power Point edit function, 
please refer to your Microsoft Power Point documentation. 
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Paste Special 
Paste Special is a Microsoft Word feature that allows you to define the 
format for a graphic pasted into a Word document.  The formats available 
depend on the version of Word you have.  The Paste Special dialog box 
below gives you four format options including Picture (Windows or 
Enhanced Metafile), Bitmap and Device Independent Bitmap. 

To use the Paste Special feature, follow these instructions: 

1. Copy a graphic to the clipboard. 

2. Open the Microsoft Word application. 

3. Go to the Word menu bar and open the Edit menu. 

4. Select Paste Special to open the Paste Special dialog box, as pictured 
below. 

 

5. Select the format for your graphic. 

× The Picture format looks best when you're not resizing an image 
with lots of text.  This format presents the image in the smallest 
file size and provides the most control for editing. 

× The Bitmap and Device Independent Bitmap formats present 
the image in the largest file size, but provides more accurate text 
and numbers when resizing an image smaller than the original. 

Note:  For detailed information about the Paste Special feature, 
please refer to your Microsoft Word documentation. 
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Save the Analysis 
After you've completed the analysis and are satisfied that all parameters 
are as you want them, you're ready to save the analysis to the database. 

Important Note:  Be aware that this save function works differently 
from the normal save function in the Windows environment.  TOPS Pro 
does not save an analysis as a file on your hard drive.  Rather, it saves the 
analysis as a record to the database – an important difference to 
remember when you need to open or search for an analysis. 

To save the analysis, follow these instructions: 

1. Click on the Save icon which opens the Analysis Save As dialog box 
appears, as pictured below. 

 

2. Enter the title for the analysis at the top field of the dialog box. 

Note:  You can use any characters up to a maximum length of 31 
characters.  If you enter a name of an unapproved analysis that has 
already been used, TOPS Pro will prompt you to overwrite the 
duplicate name. 

If the duplicate analysis is being used at the time, the system will 
reject the name and prompt you to enter another one.  There may be 
approved and unapproved (working) analyses with the same names. 

3. The analysis will be saved in the specified title in the Main Folder as 
highlighted above. 
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The other functions of the Analysis Save As dialog box are described 
below: 

× The Sort function will sort the analyses by Name, User or Date. 
Users will select the sort option in the drop down list box. 
 
Note: Analyses created with earlier versions of TOPS Pro will not 
have the user and date information. 

× The Folders section provides a tree view of all existing folders.  You 
can save the analysis into any of these folders; Main Folder is the 
default.  The area to the right of the Folders section displays a list of 
analyses that have been saved to a selected folder. 

× The Show option allows you to filter the analyses to be displayed 
based on their approval status, Approved, Working or All. Click the 
corresponding button to select the list. 

× The New Folder button allows you to create a new folder and add it 
to the current database.  
To create a new folder, click on the New Folder button. 

For more information about the Analysis Save As dialog box, please refer 
to Appendix B, Dialog Boxes. 

 

Direct Email From TOPS Pro 
TOPS Pro has an internal email feature that allows you to email a 
standard printout directly to another person who may or may not have 
TOPS Pro. 

Note:  TOPS Pro also allows you to email an analysis and a Stacking 
Strength Board Combo List.  To email an analysis, go to the Help menu 
and select the Email Problem Definition option.  To email the Stacking 
Strength Board Combo List, start from the Stacking Strength Results 
Screen, go to the Tools menu and select the Email Stacking Strength 
option. 

When you email a report or analysis to someone, TOPS Pro automatically 
attaches the appropriate files to a new email message using your default 
email application.   
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To use the direct email feature, follow these instructions: 

1. Work through the analysis until you reach the Print Preview stage of 
the process. 

2. Click on the Email button.  The system launches your default email 
application and prompts you to enter an address for the recipient, 
subject, etc., as you would for any normal email message.  TOPS Pro 
attaches the appropriate analysis files to the email message, then 
sends the message to the recipient. 

3. On the receiving end, the recipient must select all the attached files 
and save them to a common folder.  From there, the recipient can 
view the report or analysis through most any Web browser or 
Microsoft Word. 
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